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Legal Notifications 

Disclaimers 

© 1998-2019 Meridian Medical Management. All rights reserved. This publication is 

protected by copyright, is the confidential property of, and all rights are reserved by 

Meridian Medical Management. It may not, in whole or part, be copied, photocopied, 
reproduced, translated, or reduced to any electronic medium or machine-readable form 

without prior consent, in writing, from Meridian Medical Management.  

It is possible that it may contain technical or typographical errors. Meridian Medical 
Management provides this publication “as is” without warranty of any kind, either 
expressed or implied. All patient names, provider names, and offices are fictional. Any 

resemblance to actual persons or locations is purely coincidence. 

Meridian Medical Management reserves the right to make changes in specifications and 
features shown herein, or discontinue the products described at any time without notice or 

obligation. This does not constitute a representation or warranty or documentation 
regarding the product or service featured.  

Contact your Meridian Medical Management Representative for the most current 

information and/or inquiries regarding copying and/or using the materials contained in 
this document outside of the limited scope described herein. 

Meridian Medical Management 

P.O. Box 101 

Windsor, CT 06095 

Trademark Acknowledgement 

VertexDr Practice Manager ®, VertexDr Appointment Scheduler ®, VertexDr Collector ®, 
VertexDr Client Center ®, and VertexDr Electronic Health Records ® are registered 
trademarks or Meridian Medical Management. Microsoft ®, Windows XP ®, Windows Vista 

®, and Word ® are registered trademarks of Microsoft Corporation. All other products and 
company names are trademarks of their respective owners. 

Limitations and Conditions of Use 

Meridian Medical Management furnishes this document to you, a current Meridian Medical 
Management customer, as Meridian Medical Management confidential information 
pursuant to a non-disclosure agreement (NDA) or the confidentiality provisions of a 

service contract between you and Meridian Medical Management. If you are not (i) a 
current Meridian Medical Management customer, and (ii) subject to contractual obligations 

of confidentiality to Meridian Medical Management, you are not authorized to access this 
document.  
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What is Meaningful Use? 
Meaningful use refers to the program available for adopting an EMR in physician 
practices. It is part of the ARRA stimulus package. Through this program, an 

eligible professional who participates in either the Medicare or Medicaid programs 
can be eligible to receive additional monetary incentives if they are able to 

demonstrate the use of a certified EMR/EHR technology. In order to obtain the full 
amount of funding available, the eligible professional must continue to demonstrate 
the use of the EMR/EHR throughout the entire attestation period and beyond. 

Meaningful Use Terms 
Below are some of the terms used when discussing meaningful use. 

ARRA – The American Recover and Reinvestment Act was passed on 
February 17, 2009 in order to stimulate the American economy. A portion of 

the act includes billions of dollars in Medicare and Medicaid incentive 
payments to providers and hospitals for the “Meaningful Use” of certified 

health IT products. 

EMR / EHR – Electronic Medical Records / Electronic Health Records. 

Electronic charting and ordering systems which replace the need and use for 
paper records. Provides easier access to patient data, contains data and is 
stored in one place. 

 Eligible Professional (EP) – Must be one of the following: MD or DO, Doctor of 
Podiatric Medicine, Doctor of Optometry, or a Chiropractor within a list of 

specialties. Eligible for only one incentive reimbursement a year, even if the 
eligible professional works at multiple locations or practices. 

 

 

 

 

  

http://www.originhs.com/
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Meaningful Use Reports 
There are 2 reports that must be run frequently by your practice in order to ensure 
that meaningful use measures for Stage 3 are being satisfied during the reporting 

period. 

Meaningful Use Measures (Stage III) Report 
The Meaningful Use Measures (Stage III) Report provides a per-provider list of the 
required meaningful use criteria and the expected percentage of satisfaction for 

each criterion within a given date range. 

To generate the report: 

1. Click the Reports Menu and then click Meaningful Use. 

2. Click Stage III. 

3. Click Meaningful Use Measures (Stage III). The Meaningful Uses 
Measures (Stage III) Report Window displays. 

4. When finished entering the report criteria, click the OK Button to 

generate the report. 

Report Details by Measure 

The results of the Meaningful Use Measures (Stage III) Report are divided into 
Numerators and Denominators. The Numerators and Denominators are used to 
calculate the percentage satisfied for each measure (Numerator ÷ Denominator). 

Depending on the nature of the measure, there may be Exclusions. Exclusions are 
exceptions to the measure and are not used toward the calculation of the 

percentage. 

This section will explain each Numerator and each Denominator in the order they 
appear on the VertexDr generated report. 

Note: The % column indicates the minimum expected percentage of unique patients 

required during the reporting period in order to satisfy the measure. 

 

 

Core Measures 

Objective 1: Protect electronic protected health information (ePHI) 
created or maintained by the CEHRT through the implementation of 

appropriate technical, administrative, and physical safeguards. 

NA 

Note – this measure is assumed to be 100% and is not included in the 

report. 
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Objective 2: More than 60 percent of all permissible prescriptions 

written by the EP are queried for a drug formulary and transmitted 
electronically using CEHRT. 

60% 

Denominator 

Any prescription generated during reporting period. 

Numerator 

Any prescription queried for drug formulary and transmitted electronically. If 

formulary data is not turned on automatically, users will need to click the “get 
eligibility” button in the script writer prior to sending the script: 

 

 

Exclusions 

Any provider who writes fewer than 100 prescriptions during the reporting period 

(e.g. a denominator less than 100). 

 

Objective 4-1: More than 60 percent of medications created by the EP 
during the EHR reporting period are recorded using CPOE. 

60% 

Denominator 

The number of prescriptions created by the provider during the reporting period. 

Numerator 

The number of prescriptions from the denominator which were submitted 
electronically, faxed, printed or marked as Administered. 

Note: Prescriptions marked as Hand Written and/or Phoned In count toward the 

denominator, but do not satisfy the numerator for this measure. 

Exclusions 

Any provider who writes fewer than 100 prescriptions during the reporting period 
(e.g. a denominator less than 100). 

 

Objective 4-2: More than 60 percent of radiology orders created by the 
EP during the EHR reporting period are recorded using CPOE. 

60% 

Denominator 

The number of radiology orders created by the provider during the reporting period. 



vertexdr.com 
a MERIDIAN MEDICAL MANAGEMENT company 

Page | 4 

Numerator 

The number of orders in the denominator recorded using CPOE. 

Exclusions 

Any provider who writes fewer than 100 radiology orders during the reporting 
period (e.g. a denominator less than 100). 

Note: This measure should always be at 100%. An order cannot be created in the Suite 

without using CPOE. 

Objective 4-3: More than 60 percent of laboratory orders created by the 
EP during the EHR reporting period are recorded using CPOE. 

60% 

Denominator 

The number of lab orders created by the provider during the reporting period. 

Numerator 

The number of lab orders in the denominator recorded using CPOE. 

Exclusions 

Any provider writes fewer than 100 lab orders during the reporting period (e.g. a 
denominator less than 100). 

Note: This measure should always be at 100%. An order cannot be created in the Suite 

without using CPOE. 

 

Objective 5-1: More than 80 percent of all unique patients seen by the 
EP: (1) The patient (or the patient-authorized representative) is provided 

timely access to view online, download, and transmit his or her health 
information; and (2) The provider ensures the patient’s health information 

is available for the patient (or patient-authorized representative) to 
access. 

80% 

Denominator 

Encounter generated during the reporting period. 

Numerator 

A Clinical Summary CCDA is generated and sent to the patient’s portal account. 

This is done by selecting an encounter and clicking ActionClinical Summary CCDA: 
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Exclusions 

An EP may exclude from the measure if they have no office visits 

during the EHR reporting period.  

Any EP that conducts 50 percent or more of his or her patient 

encounters in a county that does not have 50 percent or more of 
its housing units with 4Mbps broadband availability according to 
the latest information available from the FCC on the first day of the 

EHR reporting period may exclude the measure.  

 

 

Objective 5-2: Use clinically relevant information from CEHRT to identify 

patient-specific educational resources and provide electronic access to 
those materials to more than 35 percent of unique patients seen by the EP 
during the EHR reporting period. 

35% 

Denominator 

Encounter generated during the reporting period. 

Numerator 

Education Resources provided electronically, via Patient Portal. With use of the Info 
Button within the Problem List, and Medication section of the patients chart. 

 

 

On the patient education window that loads, click the “Send to portal” button: 
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Exclusions 

An EP may exclude from the measure if they have no office visits 

during the EHR reporting period.  

Any EP that conducts 50 percent or more of his or her patient 

encounters in a county that does not have 50 percent or more of 
its housing units with 4Mbps broadband availability according to 
the latest information available from the FCC on the first day of the 

EHR reporting period may exclude the measure.  

 

Objective 6-1: During the EHR reporting period, more than 10 percent of 
all unique patients (or their authorized representatives) seen by the EP 

actively engage with the electronic health record made accessible by the 
provider and either: (1) view, download or transmit to a third party their 
health information; or (2) access their health information through the use 

of an API that can be used by applications chosen by the patient and 
configured to the API in the provider's CEHRT; or (3) a combination of (1) 

and (2). 

10% 

Denominator 

Encounter generated during the reporting period. 

Numerator 

Patients who view, download or transmit a CCDA via the patient portal. This is done 

when the patient accesses their portal and either views or downloads their clinical 
summary. 

Exclusions 

An EP may exclude from the measure if they have no office visits 
during the EHR reporting period.  

 Any EP that conducts 50 percent or more of his or her patient 
encounters in a county that does not have 50 percent or more of 

its housing units with 4Mbps broadband availability according to 
the latest information available from the FCC on the first day of the 
EHR reporting period may exclude the measure.  
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Objective 6-2: For more than 25 percent of all unique patients seen by 

the EP during the EHR reporting period, a secure message was sent using 
the electronic messaging function of CEHRT to the patient (or the patient-
authorized representative), or in response to a secure message sent by 

the patient or their authorized representative. For an EHR reporting period 
in 2017, the threshold for this measure is 5 percent rather than 25 

percent. 

25% 

Denominator 

Encounter generated during the reporting period. 

Numerator 

Any message from the provider sent to the patient’s portal account either in reply 
to an “ask a staff’ message, or sent directly from the patient’s chart.  

Exclusions 

An EP may exclude from the measure if they have no office visits 
during the EHR reporting period.  

Any EP that conducts 50 percent or more of his or her patient 

encounters in a county that does not have 50 percent or more of 
its housing units with 4Mbps broadband availability according to 

the latest information available from the FCC on the first day of the 
EHR reporting period may exclude the measure.  

 

 

Objective 6-3: Patient generated health data or data from a nonclinical 

setting is incorporated into the CEHRT for more than 5 percent of all 
unique patients seen by the EP during the EHR reporting period. 

5% 

Denominator 

Encounter generated during the reporting period. 

Numerator 

When the practice receives patient generated health data via the patient portal.  A 
document is populated in the patient’s chart and noted as patient generated health 
data. This needs to be defined in the definition for documents under 

DefinitionOfficeDocument Types: 
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Exclusions 

An EP may exclude from the measure if they have no office visits 

during the EHR reporting period.  

Any EP that conducts 50 percent or more of his or her patient 

encounters in a county that does not have 50 percent or more of 
its housing units with 4Mbps broadband availability according to 

the latest information available from the FCC on the first day of the 
EHR reporting period may exclude the measure.  

Note: There is additional portal set up required.  Please reference Patient 

Portal Manual. 

 

Objective 7-1: For more than 50% of transitions of care and referrals, 

the EP that transitions or refers their patient to another setting of care or 
provider of care: (1) creates a summary of care record using CEHRT; and 

(2) electronically exchanges the summary of care record. 

50% 

Denominator 

Any patient seen during the reporting period that has a transition of care to another 
provider. Transitions of care are created by selecting the encounter, then clicking 

ViewReferral Tracking 
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From here, a new Referral/Transition of care can be created: 

 

Note, “Reason for Referral” and “Diagnosis” are required fields to continue. After 

selecting any additional optional fields, selecting the “Export Transition of Care 
CCD” button will generate the CCD and give the user the option to send the CCD to 

the provider the patient is being transitioned to: 
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Numerator 

A transition of care that is generated during the reporting period and sent via Direct 
Message with confirmed receipt. Confirming receipt is done by again selecting the 

transition of care that was created for the denominator, navigating to “Referral 
Status” and filling out the review date and Status under “Review Information”: 

 

Exclusions 

 

Objective 7-2: For more than 40 percent of transitions or referrals 

received and patient encounters in which the provider has never before 
encountered the patient, the EP incorporates into the patient's EHR an 

electronic summary of care document. 

40% 
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Denominator 

Any patient with only one encounter (for the EP) in their chart generated during the 

reporting period. 

Numerator 

Any patient that has incorporated a CCD into the patient’s chart received via secure 
messaging. This is accomplished automatically when a CCD for a patient is received 

via Secure Messaging. 

Exclusions 

Objective 7-3: For more than 80 percent of transitions or referrals 
received and patient encounters in which the provider has never before 

encountered the patient, the EP performs a clinical information 
reconciliation. The provider must implement clinical information 

reconciliation for the following three clinical information sets: (1) 
Medication. Review of the patient's medication, including the name, 

dosage, frequency, and route of each medication. (2) Medication allergy. 
Review of the patient's known medication allergies. (3) Current Problem 
list. Review of the patient's current and active diagnoses. 

80% 

Denominator 

Any patient with only one encounter (for the EP) in their chart generated during the 
reporting period. 

Numerator 

Any patient who has received a CCD from a Transition of Care via Direct Messaging 

and consequently reconciles the received meds, allergies, and problems (NOTE – all 
three areas need to be reconciled in order to numerate). This is accomplished by 
going to each area of the patients chart (Meds, Allergies, and problems and 

selecting ActionClinical ReconciliationCCDA Reconcile: 
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Exclusions 

Any transitioned encounter where the EP requests a CCDA from the referring 
physician and does not receive one. The request is noted as a task in the patient’s 

chart. The task is defined under DefinitionParametersMIPS Use 
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ACI Measures 
 

ACI Objective 2 
Electronic Prescribing 

ACI EC Measure 1: At least one permissible prescription written by the MIPS EC is queried for a drug 
formulary and transmitted electronically using certified EHR technology. 

 

Denominator 

Any patient receiving a prescription during the reporting period 

Numerator 

Any prescription queried for drug formulary and transmitted electronically. If 
formulary data is not turned on automatically, users will need to click the “get 
eligibility” button in the script writer prior to sending the script: 

 

 

 

 

 

ACI Objective 5 (Measure 1) 
Patient Electronic Access 

ACI EC Measure 1: At least one patient seen by the MIPS EC during the performance period is provided 
timely access to view online, download, and transmit to a third party their health information subject to 
the MIPS EC's discretion to withhold certain information. 

 

Denominator 

Patient seen during the reporting period. 

Numerator 

A Clinical Summary CCDA is generated and sent to the patient’s portal account. 
This is done by selecting an encounter and clicking ActionClinical Summary CCDA: 
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ACI Objective 3 (Measure 2) 
 Patient-Specific Education 

ACI EC Measure 2: The MIPS EC must use clinically relevant information from certified EHR technology to 
identify patient-specific educational resources and provide access to those materials to at least one 
unique patient seen by the MIPS EC. 

 

Denominator 

Patient seen within the reporting period. 

Numerator 

Education Resources provided electronically, via Patient Portal. With use of the Info 
Button within the Problem List, Medication section of the patients chart. 

 

 

On the patient education window that loads, click the “Send to portal” button: 
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ACI Objective 4 
Secure Messaging 

For at least one patient seen by the MIPS EC during the performance period, a secure message was sent 
using the electronic messaging function of certified EHR technology to the patient (or the patient-
authorized representative), or in response to a secure message sent by the patient (or patient-authorized 
representative) during the performance period. 

 

Denominator 

Patient who was seen within the reporting period. 

Numerator 

Any patient where a secure message has been sent to the patient portal (either 

from the chart of in response to a message received via “ask a staff”). 

 

ACI CMS Objective 5 
Health Information Exchange 

ACI Measure 2: For at least one transition of care or referral received or patient encounter in which the 
MIPS EC has never before encountered the patient, the MIPS EC receives or retrieves and incorporates into 
the patient's record an electronic summary of care document. 

 

Denominator 

Any patient with only one encounter in their chart in the reporting period. 

Numerator 

Any patient where a CCD is retrieved via Direct Messaging and mapped into the 

patient’s chart. (Note, the CCD is mapped into the chart automatically upon receipt 
via secure messaging) 

Exceptions 

If a provider “requests” a CCD (via task, which is defined within the MIPS definition 

menu) and does not receive a CCD, they will be removed from the denominator: 
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ACI Objective 6  
Health Information Exchange 

ACI Measure 1: The MIPS EC that transitions or refers their patient to another setting of care or health care 
provider (1) uses certified EHR technology to create a summary of care record; and (2) electronically 
transmits such summary to a receiving health care provider for at least one transition of care or referral. 

 

Denominator 

Any patient with a referral out to an external provider (sent out as a transition of 

care) 

Numerator 

A transition of care that is generated during the reporting period and sent via Direct 
Message with confirmed receipt. Confirming receipt is done by again selecting the 

transition of care that was created for the denominator, navigating to “Referral 
Status” and filling out the review date and Status under “Review Information”: 



vertexdr.com 
a MERIDIAN MEDICAL MANAGEMENT company 

Page | 19 

 

 

 

 

 

ACI Objective 7 
Medication Reconciliation 

ACI EC Measure 1: The MIPS EC performs medication reconciliation for at least one transition of care in 
which the patient is transitioned into the care of the MIPS EC. 

 

Denominator 

Any patient seen as a Transition of care from another provider (this is tracked by 

encounter type in Definition->Office->Meaningful Use) 

 

Numerator 

Any patient who has received a CCD from a Transition of Care via Direct Messaging 

and consequently reconciles the received meds, allergies, and problems (NOTE – all 
three areas need to be reconciled in order to numerate). This is accomplished by 

going to each area of the patients chart (Meds, Allergies, and problems” And 
selecting ActionClinical ReconciliationCCDA Reconcile: 
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Clinical Quality Measures by Provider (Stage III) Report 
The Clinical Quality Measures by Provider (Stage III) Report tracks the clinical 

quality measures (CQM’s) each provider/practice has chosen to report on. 
Regardless of the measures selected, the report structure is the same: 

 Initial – Refers to the source of patient’s used for reporting clinical quality 

measures. 

 Denominator – Refers to the total number of patients seen during the 

specified date range. 

 Numerator – Refers to the number of qualifying patients seen during the 
specified time frame. 

 Exclusions – The total number of non-qualifying patients seen during the 
same period. 

The following CQMs are available for Stage III: 

CMS 2 – Preventive care and screening – Screening for depression and 
follow-up 

CMS 22 – Preventive are and screening – Screening for high blood 
pressure and follow-up 

CMS 50 – Closing the referral loop: receipt of specialist report 

CMS 65 – Hypertension: Improvement in blood pressure 

CMS 68 – Documentation of current medications in the medical record 

CMS 69 – Preventive care and screening: BMI screening and follow-up 

CMS 75 – Children who have dental decay or cavities 

CMS 90 – Functional status assessment for congestive heart failure 

CMS 117 – Childhood immunization status 

CMS 138 – Preventive care and screening: tobacco use, screening and 
cessation intervention 

CMS 146 – Appropriate testing for children with pharyngitis 

CMS 153 – Chlamydia screening for women 

CMS 155 – Weight assessment and counseling for nutrition and physical 

activity for children 

CMS 156 – Use of high-risk medications in the elderly 

CMS 165 – Controlling high blood pressure 

CMS 166 – Use of imaging studies for low back pain 
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Patient Definition 

Personal Section 

The size of the Race(s) field has been increased. 

The following options can be selected from the Name Type Dropdown: 

Note: The Name Type Dropdown is not a required field in Patient Definition. 

 Alias Name 
 Name at Birth 
 Adopted Name 

 Display Name 
 Legal Name 

 Maiden Name 
 Name of Partner/Spouse 

The option selected will be used when transmitting to immunization registries. 

Legal Name is the default selection. 

Note: The options within the dropdown are defined by CMS and cannot be changed. Also if 

you would like the 

The following options can be selected from the Address Type Dropdown: 

Note: The Address Type Dropdown is not a required field in Patient Definition. 

 Bad Address 

 Birth Address 
 Birth Delivery Location 

 Country of Origin 
 Current or Temporary 
 Firm/Business 

 Home 
 Legal Address 

 Mailing 
 Office 

 Permanent 
 Registry Home 

Note: This option refers to the public health agency location responsible for storing patient 

information. 

 Residence at birth 

The option selected will be used when transmitting to immunization registries. 

Home is the default selection. 

Note: The options within the dropdown are defined by CMS and cannot be changed. 

An additional Race field is available to satisfy a requirement of Meaningful Use, 

Stage II. 
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The following options can be selected from the Equip Type Dropdown: 

Note: The Equip Type Dropdown is not a required field in Patient Definition. 

 Beeper 
 Cellular Phone 
 Fax 

 Internet Address 
 Modem 

 Telecommunications Device for the Deaf 
 Telephone 

 Teletypewriter 
 X.400 email address 

The option selected will be used when transmitting certified phone types to 

immunization registries. Telephone is the default selection. 

Note: The options within the dropdown are defined by CMS and cannot be changed. 

Select the appropriate code from the Other ID field. The Other ID text box can be 

used to enter additional information. For example, select License Number from 
the dropdown and then enter the driver’s license number in the text box. 

Note: The Other ID dropdown and text box are not a required fields in Patient Definition. 

Note: The options within the dropdown are defined by CMS and cannot be changed. 

 

The following fields have been added to the demographics section: 

 Sexual Orientation  
 Gender Identity  

 Birth Sex 
 Multiple Birth 

 Birth Order 

 

Patient Chart 

Encounters 

Specific text can be located within an encounter. To do so: 

Note: This can also be done when viewing encounters from the Encounters Area. 
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1. When highlighted on an encounter, click the Actions Menu and then click 
Search Encounter. The Encounter Search Window displays. 

 

2. Enter the text to search for in the Search Field and then click the Find Next 
Button. 

3. Continue clicking the Find Next Button to move through the encounter 

locating the defined text. 

4. Click the Exit Button when finished. 

Allergies 

When entering allergies, a Medcin findings can be selected from the Reaction Code 
Field. 

The following options are available from Type Dropdown when entering allergies: 

 Drug Intolerance 

 Food Intolerance 
 Allergy to Substance 

 Propensity to adverse reactions 
 Propensity to adverse reactions to drug 
 Propensity to adverse reactions to food 
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Allergy Reconciliation 

When CCDs are imported, any new allergies are added to the Allergies Section of 

the Patient Chart.  

1. To view the unreconciled allergies, click the Actions Menu and then click 

CDA Reconcile Allergies or right-click on an allergy record and select 
CCDA Reconcile Allergies. 

 

2. Click the Hide Matched Button to hide the allergies that were on the 
imported CCD and are listed in the Patient Chart. 

3. Click the Show All Button to view the hidden records. 

4. Click the Remove Button to omit any allergy record that should not be 
added to the Patient Chart. 

5. Click the Merge Button to add the unreconciled allergies to the Patient Chart. 

6. A preview is displayed. Allergies can still be removed from this window if 

necessary. When ready, click the Save Button. 

Note: Allergies added to the Patient Chart from the Allergy Reconciliation Tool will have a 

comment indicating such. 

 

Medications 

Medication Reconciliation 

When CCDs are imported, any new allergies are added to the Medications Section of 
the Patient Chart.  
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1. To view the unreconciled allergies, click the Actions Menu and then click 
CDA Reconcile Medications or right-click on an allergy record and select 

CCDA Reconcile Medications. 

 

2. Click the Hide Matched Button to hide the allergies that were on the 
imported CCD and are listed in the Patient Chart. 

3. Click the Show All Button to view the hidden records. 

4. Click the Remove Button to omit any medication record that should not be 
added to the Patient Chart. 

5. Click the Merge Button to add the unreconciled medications to the Patient 
Chart. 
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6. A preview is displayed. Medications can still be removed from this window if 
necessary. When ready, click the Save Button. 

Note: Medications added to the Patient Chart from the Medication Reconciliation Tool will 

have a comment indicating such. 
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Problem List 

 A status of Cognitive Status or Functional Status can be assigned to a 

problem. 

Note: The assigned status will be included on the CCD export. 

 

If a SnoMed code is linked to the problem, the SnoMed code displays in the Patient 

Problem Definition Window when viewing problems. 

Note: The SnoMed code only displays if the problem was charted. 

Problem List Reconciliation 

When CCDs are imported, any new allergies are added to the Problem List Section 

of the Patient Chart.  



vertexdr.com 
a MERIDIAN MEDICAL MANAGEMENT company 

Page | 29 

1. To view the unreconciled problems, click the Actions Menu and then click 
CDA Reconcile Problems or right-click on a problem record and select 

CCDA Reconcile Problems. 

 

2. Click the Hide Matched Button to hide the problem that were on the 

imported CCD and are listed in the Patient Chart. 

3. Click the Show All Button to view the hidden records. 

4. Click the Remove Button to omit any problem record that should not be 
added to the Patient Chart. 

5. Click the Merge Button to add the unreconciled problems to the Patient 

Chart. 



vertexdr.com 
a MERIDIAN MEDICAL MANAGEMENT company 

Page | 30 

6. A preview is displayed. Problems can still be removed from this window if 
necessary. When ready, click the Save Button. 

Note: Problems added to the Patient Chart from the Problem Reconciliation Tool will have a 

comment indicating such. 

 

 

Implantable Device List 

A new section of the patient’s chart has been added to record implantable devices. Devices 

can be added to this list by clicking on the “New” button and typing in the implantable 

device unique identifier (UDI) 
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Documents Section 

CCDA (Continuity of Care Documents) File Import 

CCDA xml files can be imported into the Patient Chart. To do so, from the 

Documents Section, click the New Button and then click CCDA Import. 

Any medications, drug allergies, and/or problems included in the imported CCDA 
file are added to the Unreconciled Medications, Problems, and Allergies Tab in 

the respective sections of the Patient Chart. 

 If the selected has a Patient Portal account, the CCDA record can be exported 

to the Patient Portal. 

Note: Whenever a record is exported a note is made in the Correspondence Section of the 

Patient Chart. 

View Menu 

Amendments can be added to the Patient Chart. To do so: 

1. Click the View Menu and then select Patient Amendments. The Patient 

Amendment Table is displayed. 

 

2. Click the Insert Button to create a new amendment or click the Change 

Button to edit and existing amendment. The Patient Amendment Definition 
Window is displayed. 
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The following fields can be defined: 

o Date Field – This field defaults to today’s date. 

o Type Dropdown – Select Patient, Provider, or Other from the 

dropdown. 

o By Field – The name of the individual requesting the amendment can 

by entered in the Free Text Box. 

o Status Radio Buttons – Select Approved, Denied, or In Review. 

Note: In Review is selected by default. 

Comments Field – Specific information pertaining to the amendment can be 
entered in the Free Text Box. 

o Document Link – Click the link to attach a document to the 

amendment.  

Note: If a document is already attached to the amendment, the attached document is 

displayed. 

Charting 

When charting, click the View Menu and then click Vitals to display the Vitals 

Window. Enter the Height, Weight, BP (systolic and diastolic). The BMI will 
automatically calculate. 

Note: Only values greater than zero will be charted to the narrative. 

Note: Access to the Vitals Window can be placed on the Medcin Toolbar. 
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Orders 

The Collected Specimen Date and Time (in GMT format) are displayed on the 
Lab Report. 

Patient Portal 
From the Patient Chart, send a message directly to the patient’s Portal account by 
clicking Send Patient Message from the File Menu. Compose the message and 
then click the Send Button. 

Note: A different user within the practice can be selected from the From Dropdown if 

necessary. 

Patient Education Materials 
From the Problem List or Medication section of the patient’s chart, you may select 
the Info Button to generate educational materials for the patient. 

  

Patient Query Facility 
The Data Source Dropdown is arranged alphabetically. 

The following enhancements have been made to the respective Data Sources: 

Insurance 

Patients can be located by insurance and/or insurance priority. 

Note: When locating patients by insurance, the active case listed on the Insurance Section 

of Patient Definition is used by the Query Facility. 

Medication Allergies 

 When locating patients by medication allergy, the query can be filtered by 

drug or drug class. 
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 The Recorded Date can be used to locate patients with specific medication 
allergies. 

Note: If a Recorded Date is not defined, the Query Facility will search all patients with 

allergies. 

Medications 

The Date Issued can be used to locate patients by prescribed medications. 

Patient Communication Preferences 

The Patient Communication Preferences Data Source allows for patients with 

specific communication methods listed in Patient Definition to be located. 

Patient Definition 

The following fields in Patient Definition can be used to locate patients via the 
Patient Query Facility: City, State, Zip, Providing MD, Primary Care MD, Referring 

MD, Ethnicity, and Language. 

Problem List 

When locating patients with a specific problem, the Onset Date can be used as a 
filter. 

Medcin Codes/Medcin Codes with Value 

Select the Show User Name Checkbox to also list the user who charted the 

selected finding(s). 
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Secure E-Mail 
The VertexDr Practice Suite is certified to send secure e-mail communications via 
Direct. Secure e-mails are sent either when exporting CCDs or by simply generating 

a new e-mail message from the Patient Chart. 

Note: The provider must have an official Direct E-Mail account. 

Enabling Secure E-Mail 

Secure E-Mail User Security>Third Party Addins Tab 

Enter the provider’s official Direct e-mail address in the Secure Email Field. 

Enter the provider’s official Direct e-mail address password in the Password 
Field. 

Secure E-Mail Referring Provider Definition 

Secure e-mail address can be added to Referring Provider Definition. To do so, in 

the Referring Provider Definition Window, enter the referring provider’s secure e-
mail address in the Secure Email Field on the Provider Tab. 

Note: Secure e-mail addresses can only be used once. Secure e-mail addresses for 

providers in the practice should be added to the User Security Definition Window and not 

the Referring Provider Definition Window. 

Generating Secure E-Mail Messages 

Secure e-mails can be generated in several ways: 

1. When exporting CCDs,  

2. When creating referrals via Transition Of Care. 

3. From the Patient Chart by clicking the New Menu and then clicking Secure 
Email. 

Secure E-Mail Window 

The Secure E-Mail Window looks and functions like a message. Compose the e-mail 
as you would a message or any other e-mail messages. 

To enter a recipient, either type another provider’s secure e-mail address in the To 

Field or click the To Button to search for a referring provider with an associated 
secure e-mail address. 
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Transition of Care 

 Access the Referral Tracking Form 

There are several ways to access the Referral Tracking Form in our system.   

 

Access the Referral Tracking Form the following way to link this action to track for 

credit for MIPS. 

From the Patient Encounter, 

 Click the Action Menu.  Select Transition of Care from the dropdown menu. 

 

The information entered in the Referral Tracking Form is used solely by the practice 

for the record keeping purposes.   
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Referral Information Tab 

 

The Referral Tracking Form Maintenance Window opens.  The system auto-
populates the fields in the Form Identification Section. 

 

 Select any applicable checkboxes in the Attachments Section. 

 

 Information must be entered in the Reason for Referral Field.  This is so 

the Export Transition of Care Button becomes enabled. 

 

 Complete any other pertinent information in this form.  The Pertinent 

Physical Findings and Past History Fields are optional.  

 

 

 

Requested Services Tab 

 

 Click the PMD Name Dropdown Field.  Search and select the provider or 

facility the patient is being transitioned or referred to. 
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Referral Status Tab 

 

The Review Information and Committee Review Information Sections are optional. 

 

It may be helpful to note the appointment date with the referral provider/facility.   

 

 Click the Appointment Date Dropdown Field to record the appointment 

date. 

 

If the date of the appointment is unknown, it may be helpful to know the 

appointment was scheduled.   

 

 Click the Appointment Scheduled Checkbox. 
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Authorization Information Tab 

 

The Authorization Section is optional. 

 

 Click the Export Transition of Care CCD Button from any of the tabs.  
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The Referral Record Save Message Box appears. 

 

 Click the OK Button to save the referral information. 

 

 

 

 

Export the Transition of Care CCD 

 

The Patient CCD Export Window opens. 

 The All Sections Checkbox is defaulted.  Click it to uncheck it. 

 

 Click a Chart Section Checkbox to unslelect it. 

 

 Click the Also Create “Human Readable” Document Checkbox. 

 

 Click the Send in Secure-Email Checkbox.  

 

 Click the OK Button to export the CCD. 

 

Note: The Continuity of Care Document (CCD) gives a summary of the chart 
sections.  Encounter notes are not included.   
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The Secure Email Referral Window opens. 

 

 Click the To Field to search and select the recipient. 

 

 Enter a subject in the Subject Field.   

 

 Select CCD from the Document Type Dropdown Field. 

 

 Click the Document Type  Dropdown Field.  Select CCD from the dropdown 

menu.   

 

 An Attachment Field appears with the selected CCD information.  

 

 Click the Send Button to send the CCD record via direct email. 
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Recording Receipt 
 

Confirming receipt of a transition is done by again selecting the transition of care 
that was created for the denominator, navigating to “Referral Status” and filling out 

the review date and Status under “Review Information”: 
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Definition 

Office 

Profiles 

The Immunization Facility ID Field is populated when the practice is set-up 
with immunization registry. 

The CMS Certification Number Field is reserved for the VertexDr’s CMS 
certification number. 

Service Location 

An HL7 code can be entered in the HL7 Code Field. If defined, the code in this field 
will be used when exporting CCDs (Continuity of Care Documents). 

Quality Guidelines>Quality Guideline Concepts 

The Citation Field can be used to enter then the Quality Guideline source (i.e. 
website, book, etc.) If this field is populated, the source will be visible when 
the Quality Guideline Window displays in the Patient Chart. 

Note: The Citation Field will only display in the Patient Chart for Quality Guidelines that are 

populated after the practice is updated Version 8.2, Service Pack 1. 

The following fields are available in the Quality Guideline Concept Definition 

Window: 

Funding Source Field - Insert the funding source for the Quality Guideline 

Concept. 

Diagnostic Field - Enter a website for the diagnostic information pertaining to 
the Quality Guideline Concept. When the guideline is viewed in the Patient 

Chart, this field will display as a link. Click the link to open the website in the 
default browser. 

Therapeutic Field - Enter a website for the therapeutic information pertaining 
to the Quality Guideline Concept. When viewing the guideline in the Patient 
Chart, this field will display as a link. Click the link to open the website in the 

default browser.  

Meaningful Use Overrides>Overrides 

The Override Table allows for multiple unit values to be defined. 

Note: The unit values are used when exported electronic lab values on CCDs. 

To add unit values: 

1. Click the Definition Menu, then click the Office Menu, then click 

Meaningful Use Overrides, and then click Overrides. The Overrides Table 
displays. 



vertexdr.com 
a MERIDIAN MEDICAL MANAGEMENT company 

Page | 44 

 

2. Click the Insert Button to add a new unit value or click the Change Button 
to edit an existing unit value. The Override Definition Window displays. 

 

 

The following fields can be defined: 

 Type Dropdown – Currently Units is the only option available. 

Note: This field may be developed further in future releases. 

Value to Override Text Box – Enter the original lab value which will be 

overridden, such as milliliters. 

Override Value Field – Enter the lab value that will be used as the override, 

such as mls. 

Description Textbox – This field can be used to enter a description of the 
override. 

Meaningful Use Overrides>SnoMed 

Medcin may attach the same SnoMed code to a finding, regardless of the 

prefix. The Medcin Prefix/SnoMed Crosswalk Table allows for unique SnoMed 
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codes, like “Maternal history of” or “Paternal history of,” respectively, to be 
added to Medcin prefixes. 

To add a SnoMed code to a Medcin prefix: 

1. Click the Definition Menu, then click the Office Menu, then click 

Meaningful Use Overrides, then click SnoMed, and then click Medcin 
Prefix/SnoMed Crosswalk. The Medcin Prefix/SnoMed Table displays. 

 

2. Click the Insert Button to add a new Medcin Prefix/SnoMed code pairing or 

click the Change Button to edit an existing Medcin Prefix/SnoMed code 
pairing. The Medcin Prefix/SnoMed Definition Window displays. 

 

3. Select the Medcin Prefix from the dropdown and then enter the appropriate 

SnoMed code in the SnoMed Code Field. 

Note: SnoMed codes are transmitted with CCDAs (Continuity of Care Documents). They are 

not visible in the Charting Area or in the Patient Chart. 

Medcin may attach the same SnoMed code to a finding, regardless of the 
status. The Medcin Stauts/SnoMed Crosswalk Table allows for unique SnoMed 
codes, like “not done for medical reason” or “refused,” respectively, to be 

added to Medcin statuses. 

To add a SnoMed code to a Medcin status: 
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1. Click the Definition Menu, then click the Office Menu, then click 
Meaningful Use Overrides, then click SnoMed, and then click Medcin 

Status/SnoMed Crosswalk. The Medcin Status/SnoMed Table displays. 

 

2. Click the Insert Button to add a new Medcin Status/SnoMed code pairing or 

click the Change Button to edit an existing Medcin Status/SnoMed code 
pairing. The Medcin Status/SnoMed Definition Window displays. 

 

3. Select the Medcin Status from the dropdown and then enter the appropriate 
SnoMed code in the SnoMed Code Field. 

Note: SnoMed codes are transmitted with CCDAs (Continuity of Care Documents). They are 

not visible in the Charting Area or in the Patient Chart. 

Medcin contains a limited array of SnoMed codes. The Medcin/SnoMed 

Override Table allows for unique SnoMed codes to be attached to any Medcin 
finding. 

Note: SnoMed codes are transmitted with CCDAs (Continuity of Care Documents). They are 

not visible in the Charting Area or in the Patient Chart. 

To pair a Medcin finding and SnoMed codes: 

1. Click the Definition Menu, then click the Office Menu, then click 

Meaningful Use Overrides, then click SnoMed, and then click 
Medcin/SnoMed Override. The Medcin/SnoMed Table displays. 
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2. Click the Insert Button to add a new Medcin finding/SnoMed code pairing or 
click the Change Button to edit an existing Medcin finding/SnoMed code 

pairing. The Medcin/SnoMed Override Definition Window displays. 

 

 

The following fields can be defined: 

Medcin ID Field – Specify the Medcin finding by selecting or entering the 
Medcin ID. 

Note: The Medcin ID Field is required. 

 SnoMed Code Text Box – Enter the corresponding SnoMed code in the text 
box. 

Note: The SnoMed Code Text Box is a required field. 
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 Group Dropdown – If the SnoMed code override should only take place when 
the selected finding is assigned to a specific Narrative Group, select a 

Narrative Group from the dropdown. 

Note: If a Narrative Group is not selected, the override will take place regardless of which 

Narrative Group the finding is associated with. 

 Medcin Prefix Dropdown – If the SnoMed code override should only take 
place when the selected finding contains a specific prefix, select the prefix 

from the dropdown. 

 Medcin Status Dropdown – If the SnoMed code override should only take 
place when the selected finding is associated with a specific status, select the 

status from the dropdown. 

Medcin contains a limited array of SnoMed codes. The Medcin/SnoMed 

Override Table allows for unique SnoMed codes to be attached to any Medcin 
finding. 

Note: SnoMed codes are transmitted with CCDAs (Continuity of Care Documents). They are 

not visible in the Charting Area or in the Patient Chart. 

To pair a Medcin finding and SnoMed codes: 

1. Click the Definition Menu, then click the Office Menu, then click 

Meaningful Use Overrides, then click SnoMed, and then click 
Medcin/SnoMed Override. The Medcin/SnoMed Table displays. 

2. Click the Insert Button to add a new Medcin finding/SnoMed code pairing or 
click the Change Button to edit an existing Medcin finding/SnoMed code 
pairing. The Medcin/SnoMed Override Definition Window displays. 

The following fields can be defined: 

Medcin ID Field – Specify the Medcin finding by selecting or entering the 

Medcin ID. 

Note: The Medcin ID Field is required. 

 SnoMed Code Text Box – Enter the corresponding SnoMed code in the text 

box. 

Note: The SnoMed Code Text Box is a required field. 

 Group Dropdown – If the SnoMed code override should only take place when 

the selected finding is assigned to a specific Narrative Group, select a 
Narrative Group from the dropdown. 

Note: If a Narrative Group is not selected, the override will take place regardless of which 

Narrative Group the finding is associated with. 

 Medcin Prefix Dropdown – If the SnoMed code override should only take 

place when the selected finding contains a specific prefix, select the prefix 
from the dropdown. 
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 Medcin Status Dropdown – If the SnoMed code override should only take 
place when the selected finding is associated with a specific status, select the 

status from the dropdown. 

The Medcin/Loinc Override Table allows for unique Loinc (electronic lab) 

codes to be attached to any Medcin finding. 

Note: Loinc codes are transmitted with CCDAs (Continuity of Care Documents). They are not 

visible in the Charting Area or in the Patient Chart. 

To pair a Medcin finding and Loinc codes: 

1. Click the Definition Menu, then click the Office Menu, then click 
Meaningful Use Overrides, and then click Medcin/Loinc Override. The 

Medcin/Loinc Table displays. 
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2. Click the Insert Button to add a new Medcin finding/Loinc code pairing or 
click the Change Button to edit an existing Medcin finding/Loinc code 

pairing. The Medcin/Loinc Override Definition Window displays. 

 

The following fields can be defined: 

Medcin ID Field – Specify the Medcin finding by selecting or entering the 
Medcin ID. 

Note: The Medcin ID Field is required. 

 Loinc Code Field – Select the corresponding Loinc code. 

Note: The Loinc Code field is required. 

 Group Dropdown – If the Loinc code override should only take place when 

the selected finding is assigned to a specific Narrative Group, select a 
Narrative Group from the dropdown. 

Note: If a Narrative Group is not selected, the override will take place regardless of which 

Narrative Group the finding is associated with. 

 Medcin Prefix Dropdown – If the Loinc code override should only take place 
when the selected finding contains a specific prefix, select the prefix from the 

dropdown. 

 Medcin Status Dropdown – If the Loinc code override should only take place 

when the selected finding is associated with a specific status, select the 
status from the dropdown. 

Prescriptions 

Allergens 

The Allergen Table allows for Substance Codes to be linked to allergen 
descriptions. 

Note: The Substance Code field is a required field. Substance codes cannot be altered. 
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Parameters 

System Wide Defaults 

VertexDr 2 

With the Use Clinical Intervention Window Checkbox enabled, the Suite will 
verify Quality Guidelines as the patient’s record is updated with medications, lab 

orders, test results, problems, and other charted items. 

Note: The Quality Guideline Parameter Display Guidelines when Entering the Chart 

must also be enabled. 

System 

With the Do not generate images in with error logs Checkbox enabled, image 

files will not be produced when error logs are created. 

Third Party Settings 

The Infobutton Settings Field contains the web service information for the 
patient education search engine. 

Note: This field works in conjunction with the Infobutton User Security. See the User 

Security Section of this guide for more information. 

Prescriptions 

 With the Perform Interaction Checks when Entering Medication 
Allergies Checkbox enabled the system will perform an interaction check 

when a new allergy is recorded in the Patient Chart. 

Security 

Users 

VertexDr Misc 

With the Allow User Access to Infobutton Checkbox enabled, the selected user 
is able to click the Info Button on the toolbar from the Problem List Record, 

Medication Record, or a specific Lab Test Record. 

 

Auditing 

Provider Audits 

Changes made to provider suppression settings in Provider Definition are tracked. 
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Quality Guideline Concepts 

The Quality Guideline Concept audit tracks all changes made to Quality Guideline 

Concepts, including when guidelines are created. 

File Menu 

Export CCD for Patients 

The CCD can be exported as an XML file type. Once generated, the file name 

is MRN.xml. 

When a CCD is generated for a patient(s), a record of the export is noted in 

the Correspondence Section of the Patient Chart. 

The following options are available on the respective tabs in the Patient(s) CCD 
Exporter Window: 

Report Options Tab 

 Click the Output Directory Ellipse Button to select where the exported filed 
will be saved.  

Note: This field is required. 

If export patients with a specific referral reason indicated on the Referral 
Tracking Form, enter the reason in the Referral Reason Field. 

To export patients seen between specific encounter dates, enter the 

appropriate dates in the From Date and To Date Fields. 

 Click the Create “Human Readable” document Checkbox to generate an 

html file for each corresponding CCD file. 

Clients Tab 

Select the Locate by Client ID Magnifying Glass Icon to export patients for a 
specific profile, if the practice has multiples. 

Note: By default, defined patients for all profiles will be exported unless a specific profile is 

selected. 

Providers Tab 

Select one or more providers from the Providers Tab to export patients for only 
those providers. 

Note: This field reads from the provider listed on the Personal Section of Patient Definition. 

Note: By default, patients for all providers are exported unless a specific selection is made. 

Locations Tab 

Export patients associated with a specific office location by select the location(s) 
from the Locations Tab. 

Note: This field reads from the location listed on the Personal Section of Patient Definition. 
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Note: By default, patients for all locations are exported unless a specific selection is made. 

Help 

About 

The local machine data and time are displayed in the VertexDr Window. 

Note: Local machines should be synced with an NIST server for Meaningful Use, Stage II. 

 

References: 

https://www.cms.gov/Medicare/Quality-Payment-Program/Resource-Library/2018-
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Guidance/Legislation/EHRIncentivePrograms/Stage3Medicaid_Require.html 

 

https://www.cms.gov/Regulations-and-

Guidance/Legislation/EHRIncentivePrograms/2019ProgramRequirementsMedicare.html 

 

https://www.cms.gov/Regulations-and-

Guidance/Legislation/EHRIncentivePrograms/eCQM_Library.html 
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